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This manual does not provide instructions for the basic operation of
personal computers, or the basic operation of Windows® or Mac
operating systems.

Please refer to the manual that came with your computer for information
on the above mentioned topics.

• Digita™, Digita Desktop™ and the Digita logo are licensed or registered trademarks in
the United States and other countries of FlashPoint Technology, Inc.

• Microsoft® and Windows® are registered trademarks in the United States and other
countries of Microsoft Corporation.

• The official name of Windows® is Microsoft® Windows® Operating System.

• I486 and Pentium® are trademarks or registered trademarks of Intel Corporation.

• Apple, the Apple logo, Macintosh, Power Macintosh, Mac OS and the Mac OS logo are
registered trademarks of Apple Computer, Inc.

• Other company and product names are the trademark or registered trademark of their
respective owners.

• This instruction manual may not be copied either in part or in its entirety without the
prior permission of Minolta Co., Ltd.

© 1999 Minolta Co., Ltd.

• Every precaution has been taken to ensure the accuracy of this material. Please contact
Minolta if you have any questions, find any mistakes or notice missing information.

• Minolta cannot accept responsibility for any loss, damage or other problems caused by
use of this software.

• With the exception of personal, home or equivalent use no part of any book, magazine,
music, or other copyrighted material may be used, copied or revised without the prior
permission of the author or copyright holder,.

• This software has been designed to mitigate the so-called “Year 2000 Problem.” For
information on how Minolta has addressed the “Year 2000 Problem,” please visit our
Website: http://www.minoltaeurope.com

http://www.minoltaeurope.com
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BEFORE YOU BEGIN 

Please register this software before you begin using it. Complete the enclosed
user registration card.

Persons who register their software are recognized as official users, and receive
technical support as well as software upgrade and other new product informa-
tion.

• Please be aware that you will not receive any notification of registration from Minolta.

• The information contained on your user registration card is used exclusively by Minolta
for customer service and product development. The information you provide will remain
confidential.

USER REGISTRATION
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BEFORE YOU BEGIN 

• This manual assumes the use of a two-button, right-handed mouse for Windows®. The
terms ‘click’ and ‘double-click’ refer to a single or double click of the left mouse button.
The term ‘drag’ refers to the action of holding down the left mouse button while moving
the mouse.

• If you are using Macintosh OS, the term ‘Command Key’ refers to the key located next
to the Space Bar.

• Command names shown in this manual which are common both to the Windows® and
Macintosh systems do not indicate any of the shortcut keys found in Windows®

command names.

Example No. 1: The File command appears as “File” on Windows® and “File” on
Macintosh menus, but in this manual it is shown as merely as “File.”

Example No. 2: The Save command appears as “Save” on Windows® and “Save” on
Macintosh menus, but in this manual it is shown merely as “Save.”

TERMS USED IN THIS MANUAL

• This manual assumes that your computer’s operating system (Windows® 95/98/NT or
Mac OS) as well as other necessary software such as device drivers have been
installed, and are operating properly.

• If you are using a Windows® OS, click the Start button, point to Settings, and click
Control Panel. Double-click the System icon, then click the Device Manager tab. Verify
that the name of your SCSI host adapter is displayed in the tree shown under the SCSI
Controller icon.
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SYSTEM REQUIREMENTS 

The system requirements for the operation of this software are as shown below:

IBM PC/AT COMPATIBLE COMPUTERS

CPU

OS

Intel Pentium 90 MHz or higher1

Adaptec:
AVA-1505AE
AHA-1510B
AHA-1520B
AHA-1540CP
AHA-8945
AVA-2902E

AVA-2904E
AHA-2910B
AHA-2920C
AHA-2930C
AHA-2930U
AHA-2930U2

AHA-2940
AHA-2940U
AHA-2940AU
AHA-2940UW
AHA-2940U2W

RAM

HARD DISK SPACE

MONITOR

CD-ROM DRIVE

RECOMMENDED
SCSI HOST
ADAPTERS

APPLICATIONS
COMPATIBLE WITH
THE OPERATION OF
TWAIN DRIVERS

Windows® 95 (including OSR2)/98/NT4.02

32 MB or more of free hard disk memory for use as workspace

VGA (640 x 480 dots) or higher/High Colour (16-bit)

Required for installation only

Adobe Photoshop
Ver. 3.0.5/4.0.1/5.0.1/5.0.2

A minimum of 32 MB of RAM

1 Not including computers built from kits, shop-brands or other computers for which
components have been selected and assembled individually.

2 Windows® NT users should manually set their virtual memory page-file size to a
minimum of 100 MB. Users who run several programs concurrently could find that their
computer requires more. For details on how to adjust your memory settings, please refer
to your NT manual or help files.

FOR WINDOWS®
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SYSTEM REQUIREMENTS 

NOTE:
The setup program for this software will install the file Winaspi.dll ver. 4.57 on your computer’s system
(Windows® 95 only). It is possible, however, that the installation of software for other SCSI devices
automatically reinstalls an older version that is not compatible with the Dimâge RD 3000 software. In the
event that your Dimâge RD 3000 software no longer operates properly after the installation of software
for some other SCSI device, please reinstall the Dimâge RD 3000 software.

Minolta does not guarantee the performance of this software when used with a SCSI host adapter not
included in the list shown to the left. Minolta’s guarantee is limited to the assurance that the Dimâge RD
3000 will operate properly in combination with any of the SCSI host adapters included in the list shown
to the left. It does not include any assurances regarding the SCSI host adapter itself nor problems
caused by the SCSI host adapter. Minolta cannot guarantee nor provide customer support for the
operation of the SCSI host adapter with your computer.
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SYSTEM REQUIREMENTS

The system requirements for the operation of this software are as shown below:

FOR MACINTOSH

APPLE MACINTOSH SERIES COMPUTERS

CPU

OS

Power PC (Power Macintosh or Power Macintosh G3)
Excludes Mac OS compatibles.

Standard Internal SCSI host adapter
Units which have an expansion board inserted into the PCI bus or 
NuBus to effect a connection are not compatible.

RAM

HARD DISK SPACE

MONITOR

CD-ROM DRIVE

RECOMMENDED
SCSI HOST
ADAPTERS

APPLICATIONS
COMPATIBLE WITH
THE OPERATION OF
THE ADOBE
PHOTOSHOP
PLUG IN

Mac OS 7.6 to Mac OS 8.5.1. QuickTime ver. 2.5 or later is required.
QuickTime ver. 3.0 or later is required to operate the slideshow function.

32 MB or more of free hard disk memory for use as workspace

13” (640 x 480 dots) or higher/32000 Colours

Required for installation only

Adobe Photoshop
Ver. 4.0.1/5.0.1/5.0.2

16 MB or more of free memory
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SYSTEM REQUIREMENTS 

NOTE:
Minolta does not guarantee the performance of this software when used with a SCSI host adapter not
included in the list shown to the left. Minolta’s guarantee is limited to the assurance that the Dimâge RD
3000 will operate properly in combination with any of the SCSI host adapters included in the list shown
to the left. It does not include any assurances regarding the SCSI host adapter itself nor problems
caused by the SCSI host adapter. Minolta cannot guarantee nor provide customer support for the
operation of the SCSI host adapter with your computer.
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INTRODUCTION
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INSTALLING THE SOFTWARE 

Use the following procedure to install Dimâge RD 3000 software on your
computer.

FOR WINDOWS® 95/98/NT

The following explanation refers to the hard disk drive as drive C and the CD-
ROM drive as drive D.

Be sure that the Dimâge RD 3000 is not connected to your computer when you
install the software.

Turn the computer on to start up Windows®.1

Insert the Dimâge RD 3000 CD-
ROM in your computer’s disk
drive.
• The Dimâge RD 3000 setup

program opens.

2

BE SURE THAT THE DIMÂGE RD 3000 IS NOT CONNECTED TO
YOUR COMPUTER WHEN YOU INSTALL THE SOFTWARE.
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INSTALLING THE SOFTWARE 

Click the Next button.
• The Product License Agreement

opens. Please read the entire
agreement carefully before
continuing the installation.

• If you cannot agree to the terms of
the Product License Agreement,
click the No button to exit the
Setup program.

3

Click the Yes button.
• The files are copied to hard disk.

• Once the necessary files have all
been copied, the Digita Desktop
setup program closes
automatically.

4

Click the Next button.
• The Product License Agreement

opens. Please read the entire
agreement carefully before
continuing the installation.

• If you cannot agree to the terms of
the Product License Agreement,
click the No button to exit the
Setup program.

5
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INSTALLING THE SOFTWARE 

Click the Yes button.
• The installation destination folder is

displayed. If you wish to install the
software in a different folder, click
the Browse button.

6

Click the Next button.
• The program files are copied to your computer’s hard disk. Before exiting the Setup

program, you will be asked if you wish to view the Readme file.

• The Readme file contains important information not found in this manual. Be sure to
click the Yes button, and read the contents of this file carefully.

• After clicking the Yes button, the Readme.txt file is opened in Notepad. At the same
time the Exit Program dialog box opens.

• Click the OK button in the dialog box to finish the installation process, and after
viewing the Readme file, close Notepad.

7
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INSTALLING THE SOFTWARE 

• It is assumed that the CD-ROM drive is drive D.

INSTALLING THE TWAIN DRIVER (WINDOWS)

Turn the computer on to start up Windows®.1

While pressing the Shift key, insert the Dimâge RD3000 CD-ROM into
the CD-ROM drive.
• This operation bypasses the auto-play function of CD-ROM.

2

Click on “Start” and click on “Run”.3

Type D:\English\Twain\Setup.exe in the Open drop-down list, then click
on “OK”.
• Setup program will begin.

4

Click on “Next >”, then follow the directions on the screen.5

BE SURE THAT THE DIMÂGE RD3000 IS NOT CONNECTED TO
YOUR COMPUTER WHEN YOU INSTALL THE TWAIN DRIVER.
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INSTALLING THE SOFTWARE 

Before you begin
Virus protection tools and control panel documentation can be the cause of
problems during installation. These programs should be removed from your
system or temporarily disabled during installation.
The installation program does not operate properly on Japanese systems
using Japanese-language versions of QuickTime. Either remove the
Japanese-language version, and install the English-language version of
QuickTime before using the installation program, or manually drag into the
installation folder the files shown in the Where to Find the Files section on
page 21.

▼

FOR MACINTOSH

Be sure that the Dimâge RD 3000 is not connected to your computer when you
install the software.

Turn on the Macintosh.1

Once the desktop opens, insert the Dimâge RD 3000 CD-ROM in your
computer’s disk drive.

2

Once the CD-ROM is mounted, double-click the icon.3

Double-click the ENGLISH icon.
• The Dimâge RD 3000 Installer icon is displayed.

4
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INSTALLING THE SOFTWARE 

Double-click the Dimâge RD 3000 Installer icon.
• The Software License Agreement is displayed. Please read the entire agreement

carefully before continuing the installation.

• Click the Save button to save the contents of the Software License Agreement as a
text file. Click the Print button to print out the contents of the Software License
Agreement.

• If you cannot agree to the terms of the Software License Agreement, click the
Decline button to exit the installer.

5

Click the Agree button.
• The Easy Install window opens.

• If you are installing the software for the first time, leave the Easy Install settings as
they are, and proceed to the next step.

• If you wish to install only the Dimâge RD 3000 components or only the Digita
Desktop components, from the pop up menu select Dimâge RD 3000 Components
Only or Digita Desktop Components Only and proceed to the next step.

6
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INSTALLING THE SOFTWARE 

Select the installation type.

Click to select an existing folder
or create a new folder in which
the software is to be installed.

Drive and folder in which the
software is to be installed.

Click the Install button.
• The software installation begins. Follow the instructions that appear on the screen.

• Once the software installation is complete, the Digita Desktop installer opens
automatically.

• If on the previous page, "Only the component for Dimâge RD 3000" was selected
from the pop-up menu, skip steps 8 through 10 shown below and proceed directly
to step 11.

7

Click the Continue button.
• The Software License Agreement is displayed. Please read the entire agreement

carefully before continuing the installation.

• Click the Save button to save the contents of the Software License Agreement as a
text file. Click the Print button to print out the contents of the Software License
Agreement.

• If you cannot agree to the terms of the Software License Agreement, click the
Disagree button to exit the installer.

8

Click the Agree button.
• The Easy Install window opens. The drive and folder in which the software is to be

installed is displayed at the bottom left of the window.

9

Confirm the current selection, select a different folder or create a new
folder.

10
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INSTALLING THE SOFTWARE 

• Click the Check Box to the left of the files you wish to install. An “x” will appear
inside the Check Box of the files you select. Click the Left Arrow to change it to a
Down Arrow, and open a list of files. Each file can be selected individually.

• Click the i to the right of a file to view file information.

Click the Install button.
• The installer begins. Follow the instructions that appear on the screen.

• Once the installation is complete, the Restart window opens.

12

Select an Installation Type using the
pop-up menu in the upper left of the
window.
• Selecting Custom Install opens the

window shown to the left.

11

Click the Restart button.

Where to Find the Files
If you choose Simple Installation, all the files shown below are copied into
the file folder. If you choose Custom Installation, only the files you select (by
placing an “X” in the check box) are copied into the file folder.

• User-selected destination folder

Digita Desktop (application)

Goodies (folder)

• Extension

Digita Desktop (extension)

Digita Camera (extension)

Minolta Dimâge RD 3000 (extension)

13
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INSTALLING THE SOFTWARE 

INSTALLING THE SOFTWARE

Installing the Adobe Photoshop plug-in module
The installation of this plug-in module in the specified location will enable you to
open the Digita Desktop directly from Adobe Photoshop. This plug-in module is
not installed automatically. To install the module, first install the Dimâge RD 3000
and Digita Desktop, then follow the instructions shown below.
Users who do not use Adobe Photoshop do not need to install this module.

Close Adobe Photoshop, if open.1

Open the Adobe Photoshop folder.2

Open the Plug-ins folder located in the Adobe Photoshop folder.3

Open the Goodies folder located in the Digita Desktop folder.4

Drag the Digita Desktop Acquire located in the Goodies folder to the
Import/Export folder of the Plug-ins folder.

5
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INSTALLING THE SOFTWARE 

Drag the Digita Desktop Acquire located in the Goodies folder to the
Import/Export folder of the Plug-ins folder.



24

CONNECTING THE CAMERA TO YOUR PC 

Each SCSI device that is connected to your computer must be assigned its own
SCSI ID number from 0 to 7 so that the computer can identify it correctly.
Depending upon the computer, there are some SCSI ID Nos. which are pre-allo-
cated, and cannot be given to any other device. Please refer to the table below.

1 Some Macintosh models have IDE hard disk drives. On these models, ID No. 0 is
not pre-allocated.

2 Some Macintosh models have both an internal and external SCSI bus. On these
models ID No. 3 of the external SCSI bus is not pre-allocated.

The Dimâge RD 3000 has been preset to SCSI ID No. 4 at the factory. If SCSI
ID No. 4 is available for use on your computer, you need not change any settings
before installing and using it.

If SCSI ID No. 4 is already in use on your computer, it will be necessary to allo-
cate an unused ID No. to the Dimâge RD 3000.

SCSI ID SETUP

PC/AT COMPATIBLE

APPLE MACINTOSH

PRE-ALLOCATED SCSI ID NO.

No. 7 - SCSI host adapter

No. 0 - Hard disk drive1

No. 3 - CD-ROM drive2

No. 7 - The Macintosh computer
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CONNECTING THE CAMERA TO YOUR PC 

Push either the or button to
move the cursor to the ID you
wish to allocate, and push the
SET button.
• The selected SCSI ID No. is allocated

to the Dimâge RD 3000, and the SCSI
Menu reopens.

• This setting remains stored in the
camera’s memory even after the
power is turned off.

▼▲4

Push either the or button to
move the cursor to CANCEL, and
push the SET button; or push the
MENU button twice.

▼▲5

Turn the Dimâge RD 3000 Main
Switch/Mode Selector dial to
PLAY, and push the MENU button
located on the back of the unit.
• The Top Menu opens on the LCD

screen.

1

Push either the or button to
move the cursor to SCSI, and
push the SET button.
• The SCSI menu opens.

▼▲2

Push either the or button to
move the cursor to ID, and push
the SET button.
• The ID No. list opens.

▼▲3
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CONNECTING THE CAMERA TO YOUR PC 

For PC/AT compatible computers
Check the user manual of your SCSI host adapter to determine whether or not
the SCSI host adapter you are using is one that supplies power to the termina-
tor. If it is, you do not need to perform the terminator power supply setup.
Users of SCSI host adapters that do not supply power to the terminator need to
perform the terminator power supply setup in order to supply the terminator with
power from the Dimâge RD 3000.

For Macintosh computers
Users of desktop and mini-tower Power Macintosh or Power Macintosh G3
model computers do not need to perform the terminator power supply setup.
Users of PowerBook and PowerBook G3 computers with Power PC CPUs need
to perform the terminator power supply setup in order to supply the terminator
with power from the Dimâge RD 3000.

The Dimâge RD 3000 is equipped with only one SCSI connector, which means
that it can only be used as the final device on a SCSI chain. Since the final
device on a SCSI chain requires a device called a terminator, the Dimâge RD
3000 comes with a built-in terminator.

The terminator requires a power source.

TERMINATOR POWER SUPPLY SETUP

Turn the Dimâge RD 3000 Main
Switch/Mode Selector dial to
PLAY, and push the MENU button
located on the back of the unit.
• The Top Menu opens on the LCD

screen.

1

Push either the or button to
move the cursor to SCSI, and
push the SET button.
• The SCSI menu opens.

▼▲2
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CONNECTING THE CAMERA TO YOUR PC 

Push either the or button to
move the cursor to ON, and push
the SET button.
• The settings are revised to supply

power from the Dimâge RD 3000 to
the terminator, and the SCSI menu
reopens.

• This setting remains stored in the
camera’s memory even after the
power is turned off.

▼▲4

Push either the or button to
move the cursor to CANCEL, and
push the SET button; or push the
MENU button twice.

▼▲5

Push either the or button to
move the cursor to TERMPWR,
and push the SET button.
• The TERM PWR menu opens.

▼▲3



28

CONNECTING THE CAMERA TO YOUR PC 

For host adapters with 50-pin
Wide SCSI connectors:

Use the SCSI connector cable
included with your Dimâge RD 3000.

For host adapters with other
connector types:

Use a cable on which one end has a
connector that matches your host
adapter and the other end has a male
50-pin Wide SCSI connector.

For SCSI devices with 50-pin
Wide SCSI connectors:

Use the SCSI connector cable
included with your Dimâge RD 3000.

For SCSI devices with other
connector types:

Use a cable on which one end has a
connector that matches the current
terminator and the other end has a
male 50-pin Wide SCSI connector.

THE SCSI CONNECTOR CABLE

FOR PC/AT COMPATIBLE COMPUTERS

When the Dimâge RD 3000 is your only SCSI device:

When the Dimâge RD 3000 is the final device on a SCSI chain:
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CONNECTING THE CAMERA TO YOUR PC 

For desktop and mini-tower
Power Macintosh and Power
Macintosh G3 computers:

Use the SCSI connector cable
included with your Dimâge RD 3000
together with a Macintosh adapter. Note
that the Macintosh adapter connects to
the Macintosh SCSI host adapter.

For PowerBook and PowerBook
G3 computers with a PowerPC
CPU:

Use a cable on which one end has a
connector that matches the PowerBook
SCSI host adapter (HDI-30) and the
other end has a male 50-pin Wide
SCSI connector.

For SCSI devices with 50-pin
Wide SCSI connectors:

Use the SCSI connector cable
included with your Dimâge RD 3000.

For SCSI devices with other
connector types:

Use a cable on which one end has a
connector that matches the current
terminator and the other end has a male
50-pin Wide SCSI connector.

FOR APPLE MACINTOSH COMPUTERS

When the Dimâge RD 3000 is your only SCSI device:

When the Dimâge RD 3000 is the final device on a SCSI chain:
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CONNECTING THE CAMERA TO YOUR PC 

WHEN THE DIMÂGE RD 3000 IS
YOUR ONLY SCSI DEVICE:

WHEN THE DIMÂGE RD 3000 IS THE
FINAL DEVICE ON A SCSI CHAIN:

Before connecting the Dimâge RD 3000 to your computer, be sure to turn off
both the computer and the Dimâge RD 3000. Connecting the Dimâge RD
3000 to the computer while the power is on could result in damage to both
devices.

• To turn off the Dimâge RD 3000, turn the Main Switch/Mode Selector dial to Off.

CONNECTION TO THE COMPUTER

Remove or render inactive the
present terminator, and attach
the open end of the connector
cable to the SCSI connector that
had been used for the terminator.

3

Open the Dimâge RD 3000 con-
nector cover.

1

Attach the 50-pin Wide SCSI
cable connector to the Dimâge
RD 3000 SCSI connector, and
press firmly until the connector
clicks into place.

2

Attach the open end of the con-
nector cable to the SCSI host
adapter.

3
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CONNECTING THE CAMERA TO YOUR PC

Follow the instructions shown in the Dimâge RD 3000 manual to insert the
compact flash card into the card slot.

INSERTION OF THE CF CARD
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BASIC OPERATIONS 

▼

▼

▼

▼

Used to view and modify image files saved in the camera’s Compact Flash
Card (CF Card).

Open the Digita Desktop software (see pages 36 to 42).

Click the Connect icon on the Digita Desktop window.

The Camera Panel opens (see page 45).

Click the Viewer icon on the Camera panel.

The Viewer Panel opens, displaying thumbnail images of the files
saved in the CF Card (see page 46).

At the Viewer Panel:
• Copy (download) some or all of the image files saved in the CF Card to your

computer’s hard disk or other memory device.

• Display or print out an album of thumbnail images of the files saved in your
computer’s hard disk. You can also rename the files, add audio data or view a
slideshow.

• Resize or sort images, and view image properties such as size, date or image
depth.

• Delete some or all of the image files displayed in the Viewer Panel.

• Drag and drop images to move or copy them to other folders.

See page 44 for details.

BASIC OPERATION (VIEWER PANEL, IMAGE PANEL)
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BASIC OPERATIONS 

▼

▼

▼

▼

▼

Double-click the thumbnail image of the file you wish to modify 
(see page 75).

The file is opened in an Image Panel (see page 75).

Click File menu, and then click Save As (see page 100).

Select a folder in which to save the new file, enter a filename, select a
file format, and click the Save button (see page 101).

The new image file is saved (see page 101).

At the Image Panel:
• Modify a file by cropping, flipping, rotating, adding text, adjusting the brightness,

contrast and colour balance, or resizing the image.

• Zoom in and out on the image.

• Print the image.

• Convert the image to other file formats.

See page 74 for details.

Image files
• Can be displayed in a Viewer Panel.

• Can be read by other applications.

• Can be included in slideshows.
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BASIC OPERATIONS 

Operate the Dimâge RD 3000 camera from your computer.

Open the Digita Desktop software (see pages 36 to 42).

Click the Connect icon on the Digita Desktop window.

The Camera Panel opens (see page 104).

Adjust the exposure and flash settings as necessary.

Click the Remote Photography icon on the Camera Panel.

An Image Panel opens, in which the remote photography image is
displayed (see page 108).

At the Camera Panel:
• Verify the number of images taken and number of images available.

• Control Dimâge RD 3000 camera functions from the computer, including remote
photography, exposure correction, flash correction, revise clock settings and
initialisation of the CF Card.

• Perform interval photography.

See page 102 for details.

▼

▼

▼

▼

▼

BASIC OPERATION (CAMERA PANEL)
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BASIC OPERATIONS 

Click File menu, then click Save As (see page 100).

Select a folder in which to save the new file, enter a filename, select a
file format, and click the Save button (see page 101).

The new image file is saved (see page 101).

At the Image Panel:
• Modify a file by cropping, flipping, rotating, adding text, adjusting the brightness,

contrast and colour balance, or resizing.

• Zoom in and out on the image.

• Print the image.

• Convert the image to other file formats.

See page 74 for details.

Image files:
• Can be displayed in a Viewer Panel.

• Can be read by other applications.

• Can be included in slideshows.

▼

▼

▼
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OPENING THE SOFTWARE 

Push either the or button to
move the cursor to CONNECT,
and push the SET button.
• The Dimâge RD 3000 camera is now

set to the SCSI connection mode.

▼▲4

Turn on any other SCSI devices.5

Following the instructions shown on pages 24 to 31, connect the
Dimâge RD 3000 camera to your computer.

1

Turn the Dimâge RD 3000 Main
Switch/Mode Selector dial to
PLAY, and push the MENU button
located on the back of the unit.
• The Top Menu opens on the LCD

screen.

2

Push either the or button to
move the cursor to SCSI, and
push the SET button.
• The SCSI menu opens.

▼▲3
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OPENING THE SOFTWARE

FOR WINDOWS® 95/98/NT

Opening Digita Desktop as an independent application
Users who do not use TWAIN compliant applications can open the Digita
Desktop as an independent application.

Launching the TWAIN-Driver 
This example uses Adobe Photoshop version 4.0.1. This procedure will vary for
other applications. See the operating manual for your application.

Turn on your PC and start Windows®.6

Launch Adobe Photoshop.7

Select  Dimage RD 3000  from the source list.9

Click Import on the File menu, and click on TWAIN_32…
• The TWAIN driver will launch and the Minolta Dimage RD3000 index window will be

displayed on the Adobe Photoshop window.

10

Click Import on the File menu, and click on Select TWAIN_32 Source…
• The TWAIN source selection dialog box opens.

8

Turn on the computer.6

Click the start button, and point
to Programs. Next, point to the
Digita Desktop folder, and click
the Digita Desktop icon.
• The Digita Desktop control panel

opens.

7

(continued from page 36)
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OPENING THE SOFTWARE

Opening the Digita Desktop as an Adobe Photoshop plug-in
This example uses Adobe Photoshop version 4.01 which has had the Digita
Desktop installed as a plug-in. See page 22 of this manual for instructions on
installing the Digita Desktop plug-in module.

(continued from page 36)

▼

FOR MACINTOSH

Turn on the computer and start the Mac OS.6

Open Adobe Photoshop.7

Click on Import on the File menu, and click Digita Desktop Acquire.
• The capture device selection dialog box opens.

8
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OPENING THE SOFTWARE

Click MINOLTA Dimâge RD
3000, and click the OK button.
• The Dimâge RD 3000 Camera

Panel opens from within Adobe
Photoshop.

• For further details on operation,
see page 45 of this manual.

9

Double-click the application
icon.

▼

Opening Digita Desktop as an independent application
Users who do not use Adobe Photoshop can open the Digita Desktop as an
independent application.

(continued from page 36)

Turn on your Macintosh computer.6

Open the folder in which you installed Digita Desktop.7

Double-click the application icon.
• The Digita Desktop control panel opens.

8
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OPENING THE SOFTWARE



41

USING THE SOFTWARE
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OPENING THE SOFTWARE

SAVING IMAGES TO THE HARD DRIVE

Click on the images to be acquired.
• A border will surround the selected image.

• To select two or more images, press and hold the Ctrl key and click on the images
to be selected.

• To select all the images, click on “Select All” in the display.

1

Click on “Acquire”.
• The acquire function will start. When the image is being acquired, a counter will

show the progress of completion

• When complete, images are acquired into the image processing application such as
Adobe Photoshop and will be displayed on the monitor.

• Further operations on the image are passed on to the image processing application
(in this case, Adobe Photoshop). Refer to the application’s manual for details.

2

After launching the TWAIN driver, Minolta Dimage RD3000 index window will be
displayed. An index of the images stored on the CompactFlash (CF) card will be
displayed in the order in which they were taken.
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OPENING THE SOFTWARE

Some or all of images can be deleted from the CompactFlash (CF) card. Images
can be viewed before deleting when using this TWAIN driver.

DELETING IMAGES FROM THE CF CARD

QUITTING THE TWAIN-DRIVER

Click on the images to be deleted.
• A border will appear around each selected image.

• If two or more images are to be deleted, press and hold the Ctrl key and click on all
of the images to be deleted.

• To delete all the images, click on “Select All” in the display.

1

Click on “Delete”.
• The confirmation message will appear.

2

Click on “Yes” to delete the images. Click on “No” to
cancel the operation.
• The display will return to the Minolta Dimage RD3000 index window when the

delete operation is finished or canceled.

3

Click on “Exit” in the Minolta Dimage RD3000 index window.
• The confirmation message will appear.

1

Click on “Yes”.
• The TWAIN driver will quit and the display will return to the image processing

application (in this case, Adobe Photoshop).

2
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USING THE VIEWER PANEL 

The Viewer Panel can be used to view thumbnail images of image files saved in
either the CF Card or on the hard disk. You can also copy image files from the
CF Card to your hard disk.

The following operations can be performed on images displayed In the Viewer
Panel.

• Copy (download) some or all of the image files saved in the CF Card to your computer’s
hard disk or other memory device (see page 52).

• Display or print out an album of thumbnail images of the files saved on your computer’s
hard disk. Rename the files, add audio data or view a slideshow (see pages 56, 60, 69).

• Resize or sort images, and view image properties such as size, date or image depth
(see pages 62, 64).

• Delete some or all of the image files (see page 57).

• Drag and drop image files to move or copy them to other folders (see page 72).

AT THE VIEWER PANEL
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USING THE VIEWER PANEL 

Display images stored on compact frash card in the camera.

(For Macintosh)(For Windows®)

▼

DISPLAYING CAMERA IMAGES

Open the application, and click the Connect icon on the control panel.
• A list of capture devices opens.

1

Select MINOLTA Dimâge RD 3000, and click the OK button.
• The Dimâge RD 3000 Camera Panel opens.

2
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USING THE VIEWER PANEL 

• If there are too many files to display on a single screen, a scroll bar opens.
Use the mouse to click the up and down scroll arrows or drag the scroll box to
view hidden thumbnail images.

Click the Viewer button.
• The Viewer Panel will open, displaying thumbnail images of the files saved in the

CF card.

3
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USING THE VIEWER PANEL 

If an error message opens after clicking the “OK” button in Step 2, please
see page 105 of this manual.
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USING THE VIEWER PANEL

Display images saved on the hard disk.

DISPLAYING HARD DISK IMAGES

Open the application, and click the Open Folder icon on the control
panel.
• The Select a Folder dialog box opens.

1

Select a folder in which image files have been saved, and click the OK
button in Windows® or the Folder Name button in Macintosh.
• The Viewer Panel opens, displaying the image files saved in the selected folder.

2
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USING THE VIEWER PANEL 

• If there are too many files to display on a single screen, a scroll bar opens.
Use the mouse to click the up and down scroll arrows or drag the scroll box to
view hidden thumbnail images.

• Do not use Explorer or Finder to delete files that are displayed in the viewer
panel. Doing so could cause the Digita Desktop application to become
unstable.
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USING THE VIEWER PANEL

Select the desired images saved on the hard disk and dislpay them in a list.

FIND

Open the application, and click the Find button.
• The Find Files dialog box opens.

1

Enter the name of the file you wish to find.
• For example, if you wish to find a file or files on the hard disk which contain the

word “sample” in the filename, simply type “sample” in the Name Contains text
window. Specify a drive letter in the Search In text box and click the Include
Subfolders check box if you so desire.

• Click the Advanced button to display additional items. Use these items to specify
additional conditions such as date, file size or file type.

2
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USING THE VIEWER PANEL

Click the Find button.
• The Viewer Panel opens, displaying files matching the specified conditions.

All the files that match the specified conditions are show in a single window even
though some files are in different folders.

• If there are too many files to display on single screen, a scroll bar opens. Use
the mouse to click the up and down scroll buttons, or drag the scroll box to
view hidden thumbnail images

• Do not use the Explorer or Finder to delete files that are displayed in the
viewer panel. To do so could cause the Digita Desktop application to
malfunction.

3
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USING THE VIEWER PANEL 

▼

COPYING FILES FROM THE CAMERA

Follow the instructions shown on page 45 of this manual for viewing
image files saved in the CF card.

Copy some or all of the image files saved in the CF card to your hard disk or
other memory devices.

1

Point and click the image file you wish to copy. If you wish to copy
more than one file at a time, hold down the Control key, and click the
files you wish to copy.
• The filenames of selected files are highlighted.

• To deselect a filename, push the Control key, and click the filename once again.

• To copy all the files in the CF Card, click File menu, then and click Select All.

2

Click File menu, and then click Download.
• The Select a Folder dialog box opens.

3

FOR WINDOWS® 95/98/NT
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USING THE VIEWER PANEL 

FOR MACINTOSH

Select the folder to which the files are to be downloaded, and click the
OK button.
• The files begin to download. When finished, the Viewer Panel opens.

• To cancel the download, click the Cancel button on the Select a Folder dialog box
in step 3.

4

NOTE:
Downloaded image files can be viewed in the
Viewer Panel (see page 48).

Double-click an image file to open it in Image
Panel for modification (see page 75).

Follow the instructions shown on page 45 of this manual for viewing
image files saved in the CF card.

1

Point and click the image file you wish to copy. If you wish to copy
more than one file at a time, hold down the Shift key, and click the files
you wish to copy.
• The selected filenames are highlighted.

• To deselect a filename, push the Shift key, and click the filename once again.

• To copy all the files in a folder, click Viewer menu, and then click Copy All Files To
Disk.

2

Click Viewer menu, and then click Copy Selected Files.
• The download folder selection screen opens.

3
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USING THE VIEWER PANEL

▼

Select the folder to which the files will be downloaded, input the Image
File Name Prefix, and then click the Save button.
• The files begin to download. When finished, the Viewer Panel reopens.

• To cancel the download, click the Cancel button on the download folder selection
screen in step 3.

4

NOTE:
The selected images are downloaded to the specified drive and directory with names using the Image
File Name Prefix and the frame number used in the camera.

For example, if “Image” is entered as the Image File Name Prefix, and five images are downloaded, they
are named Image001, Image002, Image003, Image004 and Image005.

Downloaded image files can be viewed in the Viewer Panel (see page 48).

Double-click an image file to open in the Image Panel for modification (see page 75).
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USING THE VIEWER PANEL

▼

VIEWING IMAGE FILE PROPERTIES

Use the following procedure to view image file properties such as file format,
size, dated, date modified, and colour depth.

Display the images in the Viewer Panel (see pages 45 to 51).1

Double-click the image file you wish to view the properties.
• The selected filename is highlighted.

2

Click File menu, and then click Get Info.
• Properties for movie files or slideshow files cannot be viewed.

3
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USING THE VIEWER PANEL 

(For Windows®)

(For Macintosh)

PRINTING ALBUMS

The thumbnail images shown in the Viewer Panel can be printed out as an
album.

Display the images in the Viewer Panel (see pages 45 to 51).
• Albums can be printed from image files saved in either the CF card or the hard

disk.

• You can select some or all of the thumbnail images to create an album.

1

Click File menu, and then click Print Album.
• The Print Album dialog box opens.

2

Specify the number of columns and rows, and the desired quality.
• The size of the thumbnails images will be adjusted automatically to accommodate

the specified number of columns and rows on a single sheet.

• Click the Show Filenames check box to print the filename underneath be thumbnail
image.

3

Click the Print button.
• To close the dialog box without printing the album sheet, click the Cancel button.

4
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USING THE VIEWER PANEL 

DELETING IMAGES FROM THE CF CARD

Delete some or all of the image files saved in the CF card. Use the Viewer Panel
to verify which files you wish to delete.

Follow the instructions shown on page 45 of this manual to view the
image files saved in the CF card.

1

Click the image of the file you wish to delete. If you wish to delete more
than one file at a time, hold down the Control key, and click the files
you wish to delete.
• The selected filenames are highlighted.

• To deselect a filename, push the Control key, and click the filename once again.

• To delete all the files in a folder, click File menu, and then click Select All 
(Write-protected files can not be deleted. See page 59).

2

Click Edit menu, and then click Delete.
• The following dialog box opens.

3

To delete the selected files, click the Yes button. To cancel the Delete
operation, click the No button.
• When the delete operation is finished, the Viewer Panel reopens.

• Do not remove the CF card from the camera while the Delete operation is in
progress.

4

FOR WINDOWS® 95/98/NT
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USING THE VIEWER PANEL 

Follow the instructions shown on page 45 of this manual to view the
image files saved in the CF card.

1

Click the image of the file you wish to delete. If you wish to delete more
than one file at a time, hold down the Shift key, and click the files you
wish to delete.
• The selected filenames are highlighted.

• To deselect a filename, push the Shift key, and click the filename once again.

• To delete all the files in a folder, click Viewer menu, and then click Delete All Files
(Write-protected files can not be deleted. See page 59).

2

Click Viewer menu, and click Delete Selected Images.
• The following dialog box opens.

3

To delete the selected files, click the OK button. To cancel the Delete
operation, click the Cancel button.
• When the Delete operation is finished, the Viewer Panel reopens.

• Do not remove the CF card from the camera while the delete operation is in
progress.

4

FOR MACINTOSH
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USING THE VIEWER PANEL 

NOTE:
Write-protected files cannot be deleted (See the
camera manual for details). Attempting to delete
a write-protected file will result in the following
dialog box opening. Click the OK button to
continue to delete other files.
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USING THE VIEWER PANEL 

Enter the name of the new
folder here

New folder

▼

CREATING A NEW FOLDER

Follow the instructions shown on page 48 for viewing image files that
have been copied to your hard disk.

1

Click File menu, and then click Create New Folder.
• A new folder is created inside the Viewer Panel.

• Enter the desired name of the new folder in the highlighted text box.

2

Create a new folder on the hard disk.

FOR WINDOWS® 95/98/NT
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Follow the instructions shown on page 48 for viewing image files that
have been copied to your hard disk.

1

Click on File menu, and click Select a Folder.
• The Select a Folder dialog box opens.

2

Click the New Folder button.
• The New Folder Name text box opens.

3

Enter the desired name of the new folder in the text box and click
Create button.
• The Select a Folder dialog box opens.

4

Click the Cancel button.
• The Select a Folder dialog box closes, and the new folder is displayed inside the

Viewer Panel.

5

FOR MACINTOSH
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The size of the thumbnail images displayed in the folder panel, can be changed
to Slides, Small Slides, or List Display.

When viewing images from the CF card:

When viewing images from the hard disk:

CHANGING THE IMAGE DISPLAY

Display the images in the Viewer Panel (see pages 45 to 51).
• The image format can be changed regardless of whether the files are viewed from

the CF Card or from your hard disk.

1

FOR WINDOWS® 95/98/NT

Click View menu, and then click Slide, Small Slide, or List.2

FOR MACINTOSH

Click Viewer menu, point to View By, and then click Slide, Small Slide,
or List on the submenu.

2

Click View menu, point to View By, and then click Slide, Small Slide, or
List on the submenu.

2
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This same operation can be performed using the icons located on the Viewer
Panel toolbar.

The thumbnail image format changes as shown below:

Slide ListSmall Slide

Slide

Small Slide

List
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Thumbnail images displayed in the Viewer Panel can be sorted by filename,
date, or size.

SORTING IMAGES IN THE VIEWER PANEL

When viewing images from the CF card:

When viewing images from the hard disk:

Display the images in the Viewer Panel (see pages 45 to 51).
• Images can be sorted regardless of whether the files are viewed from the CF Card

or from your hard disk.

1

FOR WINDOWS® 95/98/NT

Click View menu, and then click Sort By. From the submenu, click the
condition you wish to use to sort the images.

2

FOR MACINTOSH

Click Viewer menu, and then click Sort By. From the submenu, click the
condition you wish to use to sort the images.

2

Click View menu, and then click Sort By. From the submenu, click the
condition you wish to use to sort the images.

2
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The same operation can be performed using the Sort By drop-down menu (Sort
By pop-up menu on Macintosh) on the Viewer Panel toolbar.

Images can be sorted by filename, audio, size, kind and date.
Name: Files are sorted alphabetically by filename.
Audio: Files with audio data are sorted first.
Size: Files are sorted by size.
Kind: Files are sorted alphabetically by file format type.
Date: Files are sorted by date.
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Use the Quick View function to display a slideshow of the images displayed in the Viewer
Panel.

• This same operation can be performed using the Quick View button located on the
Viewer Panel toolbar.

• Push any key on the keyboard to terminate the Quick View slideshow.

Quick View button

USING QUICK VIEW

Follow the instructions shown on page 48 for viewing file images that
have been copied to your hard disk.

1

Click View menu, and then click Quick View.
• The Quick View slideshow begins in accordance with the preferences described on

the following page.

2
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Return all settings
to their default
values.

Advance to the next slide after the interval (in seconds) shown in the text box.

Advance to the next slide with a mouse click.

Cancel changes,
and close the dialog
box.

QUICK VIEW PREFERENCES

Click View menu, and then click Quick View Preferences.
• The following Quick View Preferences dialog box opens.

1

After specifying your preferences, click the OK button to save the new
settings and close the dialog box.
• Run a Quick View slideshow to verify that the news settings have taken effect.

2

When selected, the image size is
automatically enlarged or reduced to
match the screen size.

When selected, the image filename is
displayed together with the image.

When selected, the Quick View
slideshow continues indefinitely.

When selected, the Quick View
slideshow always begins with the first
slide, even when paused mid-way.

Select a new background colour.

Save the new settings and close the
dialog box.
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It is not possible to change the filenames of image files in the CF Card.

The filename appears in a text box, where it
can be edited.

CHANGING FILE NAMES

Change file names of image files displayed in the Viewer Panel from the hard
disk. Use the thumbnail images to verify results of this operation.

Follow the instructions shown on page 48 for viewing image files that
have been copied to your hard disk.

1

Click the image of the file you wish to change, then click once more on
the highlighted filename.
• The current filename appears in a text box, where it can be edited.

• For Windows®: File extensions do not appear in the text box. Only the file name
itself can be changed.

2

Enter the new filename from the keyboard.3

After entering the new filename, click anywhere on the Viewer Panel to
finalise the changes.
• The new filename will appear.

• The new filename can also be finalised by pushing the Enter key (Return key on
Macintosh).

4
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This operation requires a Macintosh computer equipped with either a built-
in microphone or a microphone connected to the sound input port.

Audio data cannot be added to image files displayed from the CF Card.

Click Record on the pop up
menu.

Click and hold on the microphone icon.

▼

▼

ADDING AUDIO DATA TO AN IMAGE (MACINTOSH ONLY)

Add audio data to image files displayed in the Viewer Panel from the hard disk.

Follow the instructions shown on page 48 for viewing files that have
been copied to your hard disk.

1

Click and hold on the microphone icon shown in the upper right corner
of the image file to which you wish to add audio. Next, click Record on
the pop up menu that opens.
• The Record dialog box opens.

2



70

USING THE VIEWER PANEL 

The microphone icon changes to a speaker
icon.

Click the Record button “ ” to begin recording audio data.
Use the microphone to record audio data.
• The maximum amount of time which can be recorded depends on how much

memory your Macintosh computer has; the elapsed recording time will appear in
the progress bar of the Record dialog box.

• Click the Stop button “ ” to stop recording.

• Click the Play button “ ” to play back your recording.

• Re-record as many times as necessary until you are satisfied.

▼

■

●3

Click the Save button.
• The audio data is saved.

• The microphone icon in the upper right hand corner changes to a speaker icon.

4
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Replay the audio data.

Delete the audio data.

Click and hold on the speaker icon.

▼

Click and hold on the speaker icon. Next, the pop-up menu will open.
• Click Play to replay the audio data.

• Click Delete to remove the audio data. The speaker icon will change to a
microphone icon.

5
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Files can copied or moved by dragging and dropping them from the Viewer
Panel to the Windows® Explorer or the Macintosh Desktop.

DRAG AND DROP OPERATION

Follow the instructions shown on page 48 for viewing image files that
have been copied to your hard disk.

1

Click the Start button, point to Program, and click Explorer to open the
Windows® Explorer, and display the target folder. For Macintosh com-
puters, use the Finder to display the target folder.

2

At the Viewer Panel, click the image you wish to copy or move.3

Drag and drop the image file you wish to move or copy to the target
folder.
• If the target folder is located on the same hard disk partition (the same drive letter)

(the same volume for Macintosh) as the source folder, then the file is moved to the
target folder, and is deleted from the source folder. If the target folder is located on
a different hard disk partition (a different drive letter) (a different volume for
Macintosh) as the source folder, then the file is copied to the target folder, but is not
deleted from the source folder.

4
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Click on the image file you wish to move or copy, and drag it to the target
folder. Release the mouse button to drop the image file in the target folder.
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WHAT YOU CAN DO AT THE IMAGE PANEL

The following operations can be performed in the Image Panel
• Zoom in and out on the image (see page 79).

• Image files can be modified as follows: (see pages 80 to 94)

• Image files can be printed (see page 96).

The Image Panel can be used to modify, print or save image files in a variety of
formats.

For Windows®:

bmp, exif, jpeg, pict, tiff, Photoshop3.0 (psd), FlashPix

For Macintosh:

bmp, exif, jpeg, pict, tiff

• Image files can be saved to hard disk in the following file formats 
(see page 98).

Change the size of documents

Crop

Adjust brightness and contrast

Adjust colour balance

Apply Quick Correction to images (minute adjustment of brightness and
enhancement of outlines)

Flip the image

Rotate the image

Superimpose text

Change the size of the image
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Use the Image Panel to view, modify and print image files saved in the CF Card.

▼

Double-click

DISPLAYING CAMERA IMAGES

Follow the instructions shown on page 45 of this manual for viewing
image files saved in the CF Card.

1

Double-click the image you wish to view.
• The data for the selected image file is read from the CF card to the memory of the

PC. Once this operation has been completed, the selected file opens in the Image
Panel.

2
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In cases where the Digita Desktop has been open as an Adobe Photoshop plug-
in, double-click on an image in the Viewer Panel to open that file as a New
Image for editing in Adobe Photoshop.

At this point, editing of the file is performed from within Adobe Photoshop. For
further details, see the operating manual for your software.

Using the Digita Desktop Photoshop Plug-In (Mac OS only)
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▼
Double-click here.

Double-click on an image in the Viewer Panel to open that file as a New
Image for editing in Adobe Photoshop.

• Starting on the following page is an explanation of how to use the Digita Desktop as
an independent application.
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▼

DISPLAYING HARD DISK IMAGES

Using the Image Panel to view images saved on the hard disk.

Click the Open File icon on the control panel.
• The standard Open File dialog box for your operating system opens.

1

Click the image file you wish to view, and then click the Open button.
• The selected file opens in the Image Panel.

2

NOTE:
If you wish, you may also follow
the instructions shown on page
48 for viewing image files that
have been copied to your hard
disk in the Viewer Panel.
Double-click the image you wish
to open in the Image Panel.
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Zoom Tool

Zoom ratio pull-
down menu.

ZOOM IN/ZOOM OUT

The zoom function displays images as large as 1600% or as small as 3% of
their actual size (400% to 25% for Macintosh).

Click the Zoom Tool button on the tool palette.
• The mouse pointer changes to the Zoom Tool pointer.

1

Using the Zoom Tool pointer, click the image to zoom in. Hold down the
control key (option key for Macintosh) and click to zoom out.
For Windows®

• Zoom-in ratios: 100% (actual size), 200%, 400%, 800%, 1600%

• Zoom-out ratios:100% (actual size), 50%, 25%, 12%, 6%, 3%
For Macintosh
• Zoom-in ratios: 100% (actual size), 150%, 200%, 300%, 400%

• Zoom-out ratios:100% (actual size), 75%, 50%, 25%
This operation can also be performed as shown below:
• Use the pull down menu on the tool palette to specify a zoom ratio.

• Click either Zoom In or Zoom Out on the Image menu.

2
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▼

For example, make adjustments as
shown on the left and click the OK
button to effect changes as shown
on the next page.

RESIZING DOCUMENTS

On the Image menu, click Document Size.
• The Document Size dialog box opens.

1

Specify a new width and height, and select the desired placement
method. Then click the OK button.

2
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▼

NOTE:
To cancel changes made in this manner, click Undo on the Edit menu. This
function can be used to undo a series of operations (only the most recent
operation for Macintosh). The number of operations which can be undone
varies with the amount of memory on your computer.
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Selection Tool

▼

▼

CROPPING THE IMAGE

Trim the unwanted portions of an image.

Click the Selection Tool on the tool palette.
• The mouse pointer changes to a cross.

1

Select the portion of the image you wish to crop by dragging the cur-
sor across the image.
• The selected area is bordered with a dotted line.

2

On the Image menu, click Cut.
• The selected portion of the image is cut.

3

NOTE:
To cancel changes made in this manner, click
Undo on the Edit menu. This function can be
used to undo a series of operations (only the
most recent operation for Macintosh). The
number of operations which can be undone
varies with the amount of memory on your
computer.
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Pan Tool

SCROLLING THE IMAGE

Click the Pan Tool on the Tool Pallet.
• The mouse pointer changes to the Pan Tool icon.

1

If the image is larger than the Image Panel window, use the Pan Tool.

Drag the image to scroll.2
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▼

ADJUSTING BRIGHTNESS AND CONTRAST

Adjust the brightness and contrast of the image.

On the Image menu, click Brightness/Contrast.
• The Brightness/Contrast dialog box opens.

1

Click the slider and drag, or enter a numerical value directly into the
text box to the right of the slider bar.
• The brightness and contrast of the image will change as the slider moves or as the

values are entered.

2

When finished, click the OK button.
• Click the Cancel button to cancel the changes, and close the Brightness/Contrast

dialog box.

• Click the Reset button to cancel the changes, and return the values to 0. The
sliders will return to the center of the slider bar.

3
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▼

ADJUSTING COLOUR BALANCE

Adjusts the RGB colour balance of the image.

On the Image menu, click Colour Balance.
• The Colour Balance dialog box opens.

1

Click the slider and drag, or enter a numerical value directly into the
text box to the right of the slider bar.
• The colour balance of the image will change as the slider moves or as the values

are entered.

2

When finished, click the OK button.
• Click the Cancel button to cancel the changes, and close the Brightness/Contrast

dialog box.

• Click the Reset button to cancel the changes, and return the values to 0. The
sliders will return to the center of the slider bar.

3
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USING THE QUICK CORRECTION FUNCTION

Make minute adjustments to brightness or enhance the edges of the image
using just the menu commands.

LIGHTEN/DARKEN

On the Image menu, point to Adjust, and select either Lighten or
Darken from the submenu.
• The image’s brightness changes accordingly.

NOTE:
To cancel changes made in this manner, click
Undo on the Edit menu. This function can be
used to undo a series of operations (only the
most recent operation for Macintosh). The
number of operations which can be undone
varies with the amount of memory on your
computer.
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SHARPEN/SOFTEN

On the Image menu, point to Adjust, and select either Sharpen or
Soften from the submenu.
• The Sharpen function enhances the outlines of the image. It will give a slightly out-

of-focus image a sharper appearance. This function also increases image noise,
making the image grainy.

• The Soften function degrades the outlines of the image. Minute details all are
blurred, making the image fuzzy.

• Not all images are suitable for enhancement with these functions.

NOTE:
To cancel changes made in this manner, click
Undo on the Edit menu. This function can be
used to undo a series of operations (only the
most recent operation for Macintosh). The
number of operations which can be undone
varies with the amount of memory on your
computer.
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On the Image menu, point to Flip, and select either Horizontal or
Vertical.
• The image is flipped.

• This operation can also be performed using the buttons on the Tool Palette.

Flip vertical

Flip horizontal

FLIPPING AN IMAGE (HORIZONTALLY OR VERTICALLY)

Flip the images along the horizontal or vertical axis.
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Vertical

NOTE:
To cancel changes made in this manner, click
Undo on the Edit menu. This function can be
used to undo a series of operations (only the
most recent operation for Macintosh). The
number of operations which can be undone
varies with the amount of memory on your
computer.
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Rotate 90° left

Rotate 90° right

ROTATING AN IMAGE

Rotate an image 90º left, 90º right or 180º.

On the Image menu, point to Rotate, and select 90º Left, 90º Right
or 180º.
• The image is rotated as indicated.

• This operation can also be performed using the buttons on the Tool Palette.
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Image rotated
90° left

Image rotated
90° right

Image rotated 180°

NOTE:
To cancel changes made in this manner, click Undo on the Edit menu. This function can be used to
undo a series of operations (only the most recent operation for Macintosh). The number of
operations which can be undone varies with the amount of memory on your computer.
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Text Tool

Input text from the keyboard.

The text input is finalised, and the border of the text box
is highlighted in diagonal lines.

SUPERIMPOSING TEXT

Superimpose text onto an image.

Click the Text Tool button on the Tool Palette.
• The mouse pointer changes to the Text Tool pointer.

1

Move the Text Tool pointer to the desired location, and click.
• A text box opens.

2

Input text from the keyboard.
• Macintosh users can ignore step 4, then proceed directly to step 5.

3

Click anywhere outside the text box.
• The text input is finalised, and the border of the text box is highlighted in diagonal

lines.

• Click inside the text box to revise the text.

• If the border of the text box disappears when the mouse is double-clicked, click
Undo on the Edit menu to redisplay the text box border.

4
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Point the mouse at any side of the text box border
to display this cursor. Drag the cursor to change the
location of the text box.

For Macintosh, pointing the mouse at any side of
the text box border will display this cursor.

Point the mouse at any one of
the four corners of the text box
border to display this cursor.
Drag the cursor to adjust the size
of the text box. Adjust the size of the text box.

▼

For Windows®

For Macintosh

Point the mouse at any one of the four corners of the text box border to
display the resize cursor. Drag the cursor to adjust the size of the text
box.
Point the mouse at any side of the text box border to display the move
cursor. Drag the cursor to change the location of the text box.

5

Use the toolbar buttons to change the font type, size or colour, as well
as the text style and format (Macintosh users can also adjust the back-
ground colour).

6

Double-click outside the text box to finalise.7

Italics

Underline

Font type Font size

Text colour

Background colour

Bold

center

right

left

Style Alignment
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▼

RESIZING THE IMAGE

Change the size of the image.

On the Image menu, click Resize.
• The Resize dialog box opens.

1

Use the drop-down menu to select the units you wish to use.2

Input new values for Width and Height, and click the OK button.
• If the Preserve Aspect Ratio option (Maintain Aspect Ratio for Macintosh) is

checked, inputting a new value in either the width or height text box will
automatically adjust the remaining value to maintain the original ratio.

• Click the Cancel button to cancel the operation, and close the dialog box.

• Extreme resizing could result in deterioration of image quality.

3

NOTE:
To cancel changes made in this manner, click
Undo on the Edit menu. This function can be
used to undo a series of operations (only the
most recent operation for Macintosh). The
number of operations which can be undone
varies with the amount of memory on your
computer.
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Installation of plug-in filters will expand the functionality of the Digita Desktop.

DIGITA DESKTOP IMAGE FILTERS AND PLUG-IN FILTERS

NOTE:
There are no plug-in filters included in the Digita
Desktop installation.
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(For Windows®)

(For Macintosh)

PRINTING IMAGES

Print the image. NOTE:
The Print dialog box that opens will vary
depending upon your printer. See your printer’s
user manual for details.

On the File menu, click Print Setup. Macintosh users click Paper Setup.
• The Print Setup (Paper Setup) dialog box opens.

1

Set your preferences for printer, paper and orientation, then click the
OK button.

2
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(For Windows®)

(For Macintosh)

On the File menu, click Print.
• The Print dialog box opens.

3

Set your preferences for printer, print range and number of copies.4

When you are ready, click the OK button (Print for Macintosh).5
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SAVING AN IMAGE

Images can be saved to hard disk in a variety of file formats.

Images displayed in the Image Panel can be saved in any of the following file
formats:

IMAGE FILE FORMATS

BMP BMP is the standard Windows® image file format. Files
saved in this format may be viewed with Microsoft Paint
or other standard software.

EXIF(EXIF2.0) EXIF is the acronym of Exchangeable Image File
Format. Images taken with the Dimâge RD-3000 are
stored in the compact flash card in this format. EXIF
2.0 is an enhancement of EXIF 1.0, which supports
JPEG compression, simple structure, and recording of
supplementary information, but which also supports
new information tags such as recording of audio infor-
mation during photography, and photographic settings
information. It also permits simple conversion of colour
information and additional information quickly, without
image deterioration, and without information dropout.

PICT PICT is the standard Macintosh image file format. Files
saved in this format can be viewed with Simple Text or
other standard software.

JPEG JPEG the acronym of Joint Photographic Experts
Group. JPEG has become an international standard for
compression and expansion of static images. It fea-
tures the ability to compress data for full colour images.
Like the TIFF format, JPEG platform-independent and
provides a high compression ratio with relatively little
loss of image quality, making it suitable for a wide
range of applications.
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TIFF TIFF is the acronym of Tag Image File Format, a for-
mat that supports high-resolution bitmap files.
Compatible with any number of platforms, it may be
used with the IBM PC/AT compatible, Macintosh or
other systems.

Photoshop 3.0 (PSD)1 This is a proprietary file format developed for the
Adobe Photoshop 3.0 image processing application by
Adobe Systems Incorporated.

FlashPix1 A file format developed jointly by Kodak, Microsoft,
Hewlett-Packard, and Live Picture Corporation as an
international standard for computer image files. It sup-
ports many features not available with other image file
formats, including the following:
• All images are divided into 64 x 64 pixel files so that

unnecessary data need not be processed during
enlargement and movement. Each tile is compressed with
the JPEG format, thus minimizing loss of image data.

• Each file comprises multiple high-resolution files allowing
the image to be automatically displayed at the optimum
resolution.

• Images are displayed at optimum resolution, and only the
image data tiles for the visible part of the image are
processed, so memory use and processing power all are
minimiy

1The Photoshop 3.0 (PSD) and FlashPix format are available only under Windows®
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▼

(For Windows®)

(For Macintosh)

On the File menu, click Save As.
• The Save As dialog box opens.

1

SAVING IMAGES
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Select a folder in which to save the image.
• To create a new folder, click the Create New Folder icon (New for Macintosh).

• Click the Cancel button to cancel the operation and close the dialog box.

2

Input the new filename.3

Select the desired file format from the File Type drop-down menu (File
Format pop-up menu for Macintosh).
• For Windows®, the correct file extension is automatically added to the filename.

4

Click the Save button.
• The image is saved in the specified folder and file format, and the Image Panel

reopens.

5
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• Verify the number of frames used, and the number of frames remaining.

• Display image files stored in the cameras CF card using the Viewer Panel (see
page 106).

• Control camera (Dimâge RD 3000) functions from the PC (see pages 107 to
113).

Remote photography

Control exposure and flash corrections during remote photography

Revise the Dimâge RD 3000’s internal clock

Initialise the CF card

• Interval photography (see page 114)

WHAT YOU CAN DO FROM THE CAMERA PANEL

The Camera Panel is an interface which allows you to control your camera
(Dimâge RD 3000) from your PC.

The following the operations can be performed at the Camera Panel:
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Display thumbnail images of the files
stored in the CF card in the Viewer
Panel (see page 106).

Perform remote photography 
(see page 107).

Open the Camera Settings dialog
box (see page 110).

Open the Time Lapse Capture
dialog box (see page 114).

Indicates exposure and flash corrections (see page 107).
These buttons are not displayed when the value is 0.0.

Open the Exposure/Flash Correction dialog box 
(see page 107).

Close the Exposure/Flash Correction dialog box 
(see page 107).

Use the mouse to drag the sliders
and change the exposure/flash
correction values. The correction
value range is from -3.0 to +3.0 in
increments of 0.5 (see page 107).

CAMERA PANEL
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▼

▼

(For Windows®) (For Macintosh)

Following instructions shown on pages 36 to 42 for opening the Digita
Desktop control panel.

1

Click the Connect icon on the control panel.
• The Select Capture Device dialog box opens.

2

Select MINOLTA Dimâge RD 3000, and click the OK button.
• The Dimâge RD 3000 Camera Panel opens.

3

TO OPEN THE CAMERA PANEL
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When the computer is unable to detect a connection to the Dimâge RD 3000,
the following error message dialog box opens.

In such a case, perform the following troubleshooting operations:

Click the OK button to close the error message dialog box.1

Click the Close button in the upper right corner of the Digita Desktop
control panel to close the application. Mac users should click Exit on
the File menu.

2

Check the following:
• Is the SCSI cable connected properly? (see page 30)

• Has the SCSI cable separated from a connector?

• Has the SCSI cable been cut or damaged?

• Is the SCSI ID number allotted to the Dimâge RD 3000 already in use by another
SCSI device? (see page 24)

• Has the terminator been properly supplied with power? (see page 26)

• Did you turn on the Dimâge RD 3000 before turning on your PC? (see page 36)

• Did you set the Dimâge RD 3000 to PC connect mode before turning on your PC?
(see page 36)

• Has a CF card been inserted into the Dimâge RD 3000? (see page 31)

3

After verifying that all of the above have been performed properly, fol-
low the instructions on pages 36 to 42, open the Digita Desktop control
panel, and once again connect to the Dimâge RD 3000.

4

WHEN THE CAMERA PANEL DOES NOT OPEN
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▼

Follow the instructions shown on page 44, Using the Viewer Panel, for opera-
tions that can be performed.

Click the Viewer button.
• The Viewer Panel opens, displaying thumbnail images of the files stored in the CF

card.

1

DISPLAYING CAMRA IMAGES
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Use the mouse to drag the
sliders and change the
exposure/flash correction
values.

Release the Dimâge RD 3000 shutter from your PC.

Adjust the exposure and flash correction value as necessary. If such a correction
is unnecessary, proceed to step No. 3.

NOTE:
Using the exposure correction and flash correction properly

The exposure correction is used to lighten or darken the overall area of the picture frame.

The flash correction controls the amount of light released by the flash unit.

For example, when photographing human subjects outdoors, using only the exposure correction will
affect the entire picture, even areas unaffected by the flash such as the background. Use of the flash
correction will not affect the background, but will lighten/darken the areas around the subject which can
be reached by the flash.

The exposure correction and flash correction can be used simultaneously.

Click the button ( button for Macintosh) on the Camera Panel.
• The Exposure/Flash Settings dialog box opens.

▼▼1

Use the mouse to drag the sliders and change the exposure/flash cor-
rection values.
• The correction value range is from -3.0 to +3.0 in increments of 0.5.

• Click the button ( button for Macintosh) again to save the settings, and close
the Exposure/Flash Settings dialog box.

▼

▼

2

REMOTE PHOTOGRAPHY
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USING THE CAMERA PANEL 

▼

Click the Capture button.
• The shutter releases, and the Image Panel opens to display the photograph.

3
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USING THE CAMERA PANEL 

NOTE:
The Dimâge RD 3000 is configured so that the shutter will not release unless the camera is in focus.
When you click the Capture button, your PC will send a release signal to the Dimâge RD 3000 for
approximately 20 seconds. During this time, a picture will be taken when the subject comes into focus
(Or, during flash photography, when the flash has recharged).

If during that 20-second interval, the camera is unable to focus or the flash does not recharge, no
picture is taken. In which event, a “Shutter was not Released” error message is displayed. Click the OK
button to close the error message dialog box, and return the program to stand-by status.
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USING THE CAMERA PANEL 

All data stored in the CF card is lost during formatting. Since this data cannot
be recovered, take care when performing the format operation.

▼

CAMERA SETTINGS

Use your PC to format the Dimâge RD 3000 CF card, set the Dimâge RD 3000
internal clock, or synchronise the internal clock with your PC clock.

FORMATTING THE CF CARD

Click the Setting button.
• The Camera Settings dialog box opens.

1
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USING THE CAMERA PANEL 

Click the Format button.
• The confirmation dialog box opens.

2

Click the Yes button.
• The CF Card is initialised, and the Camera Panel opens.

• To cancel the format operation, click the No button.

3
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USING THE CAMERA PANEL 

Before performing this operation, verify that your PC clock is correct.

For Windows®: Click the Start button, point to Settings, and then click Control
Panel. Click the Control Panel Time and Date icon.

For Macintosh: On the Apple Menu, select Control Panel, and click Time and
Date.

▼

SYNCHRONISING THE INTERNAL CLOCK WITH YOUR PC CLOCK

Click the Setting button.
• The Camera Settings dialog box opens.

1
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USING THE CAMERA PANEL

Click the Set Clock button.
• The time and date settings are transferred from the PC to the Dimâge RD 3000

internal clock.

• After the internal clock is synchronised, the camera panel opens.

2
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USING THE CAMERA PANEL 

If the Frames Remaining value is 0, delete an image file or replace the cur-
rent CF card with one which has a Frames Remaining value of at least 1.

Before performing interval photography,
check that the Frames Remaining value
on the Camera Panel dialog box is at
least 1.

INTERVAL PHOTOGRAPHY

Automatically record a series of photographs taken at a specified time interval.

During interval photography, each recorded frame is initially stored in the CF
card, after which it is saved in the specified folder on your hard disk.
To perform interval photography you must therefore have enough space in your
CF card for a minimum of one frame.

Follow the instructions on page 107 for adjusting the exposure/flash
correction value.
• If this operation is unnecessary, proceed to the next step.

1

Click the Time Lapse button.
• The Time Lapse Capture dialog box opens.

2
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USING THE CAMERA PANEL 

(For Windows®) (For Macintosh)

▼
▼

Set the values for time interval and number of pictures to your prefer-
ences.
• Click the arrows, or input a value directly into the text box to select your

preferences for time interval and number of frames.

• The minimum time interval value is one minute; the maximum time interval value is
24 hours and 59 minutes.

• The minimum number of frames is 1; the maximum number of pictures is 999.

3

Specify a filename prefix.
• Specify a filename prefix in the text box.

• Image files created by the interval photography process have filenames consisting
of the specified filename combined with a four digit number.

For example, if the filename is specified as “image,” and 20 frames are taken, the
first file is named “image0001.jpg” and the last file is named “image0020.jpg.”

4

NOTE:
To cancel the interval photography operation,
click the Cancel button.
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USING THE CAMERA PANEL 

Specify a folder in which to save the image files.
• To change the current folder, click the Browse button, and choose a new folder

(Select button on Macintosh).

• Verify that the there is enough free space on the hard disk drive (volume on
Macintosh) to save all of the image files you plan to record. If there is not enough
free space on the hard drive, the interval photography process is terminated
without warning.

5

Click the Start button.
• The following dialog box opens. Verify that the contents are correct.

6



117

USING THE CAMERA PANEL 

Click the Start button again to start the Time Lapse.
• Interval photography will begin in accordance with the preferences specified in

steps 3 to 5.

• When the interval photography is completed, the Camera Panel opens.

7

NOTE:
The Dimâge RD 3000 is configured so that the shutter will not release unless the subject is in focus.
During Remote Photography, each time the specified interval passes, your PC will send a release signal
to the Dimâge RD 3000 for approximately 20 seconds. During this time, a picture will be taken once the
camera comes into focus. (Or, once the flash has recharged during flash photography) If, during that 20-
second interval, the camera remains out of focus or the flash does not recharge, no picture is taken. The
camera will wait for the specified time internal to take the next picture.
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SLIDESHOWS 

QuickTime 3.0 or later is required to operate a slideshow on Macintosh
computers.

WHAT IS A SLIDESHOW?

A series of image files can be displayed in succession on your computer, simu-
lating a slideshow.

The following operations are also possible:
• Record audio data for each individual image to be replayed during the slideshow (see

page 128).

• Attach background music to the slideshow (see page 130).

• Specify a time interval for each slide, or advance to the next slide with a mouse-click
(see page 132).

• Save the slideshow in a file (see page 134).

• Convert the slideshow to an AVI file for Windows® or a QuickTime movie file for
Macintosh (see page 136).
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SLIDESHOWS 

▼

Click the Add Folder
button to append all the
image files in a folder to
the slideshow.

Click the Add Slide button
to append individual
image files to the
slideshow.

TO OPEN THE SLIDESHOW WINDOW

Follow the instructions shown on pages 36 to 42 for opening the Digita
Desktop control panel.

1

Click the Create icon on the control panel.2

In the Select a Document to Create dialog box, select Slideshow, and
click the OK button.
• The new Slideshow window opens.

3
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SLIDESHOWS 

APPENDING IMAGE FILES TO A SLIDESHOW

APPENDING INDIVIDUAL IMAGE FILES

Append image files to a slideshow. Image files can be appended individually, or
all the image files in a folder can be appended at once.

Follow the instructions on page 119 for opening the slideshow window.1

On the Slideshow menu, click Add Slide.
• This operation can also be performed by clicking the Add Slide button on the

toolbar.

• The standard Open a File dialog box for your operating system opens.

2

(For Windows®)

(For Macintosh)
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SLIDESHOWS 

Select the file you wish to append, and click the Open button (Select
button on Macintosh).
• The selected file is appended to the slideshow, and appears in the slideshow

window.

3

Repeat steps 2 and 3 as necessary.4
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SLIDESHOWS 

APPEND ALL THE IMAGE FILES IN A FOLDER

Follow the instructions shown on page 119 for opening the slideshow
window.

1

On the Slideshow menu, click Add Folder of Slides.
• This operation can also be performed by clicking the Add Folder button on the

toolbar.

• The Select a Folder dialog box opens.

2

(For Windows®)

(For Macintosh)
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SLIDESHOWS 

Select the folder containing the image files you wish to append, and
click the OK button (Select button on Macintosh).
• All the image files contained in the specified folder are appended to the slideshow,

and appear in the slideshow window.

3
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SLIDESHOWS 

CHANGING THE DISPLAY OF FILES IN THE SLIDESHOW WINDOW

FOR WINDOWS® 95/98/NT

FOR MACINTOSH

The slide image displayed in the slideshow window, can be changed to Slide,
Small Slides, or List Display.

On the Slideshow menu, point at View By, and select Slide, Small Slide
or List.

1

On the Slideshow menu, point at View, and select Slide, Small Slide or
List.

1
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SLIDESHOWS 

Slide

Small Slide

List

This same operation can be performed by clicking the appropriate button on the
toolbar.

The slideshow window display changes as shown below:

Small Slide

List

Slide
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SLIDESHOWS 

Drag the slide to its
new location, verify
the new location with
the arrowhead, and
release the mouse.

CHANGING THE ORDER OF SLIDES

Change the order in which the slides are viewed.

Drag the slide to its new location. Verify the new location with the
arrow that appears in the space between the filenames, and release the
mouse button to finalise.

1

UPDATING SLIDES (WINDOWS® ONLY)

If you have used the Image Panel to modify an image file, use this command to
update the thumbnail images.

Click the slide you wish to update.1

On the Slideshow menu, click Update Selected Slides.
• Use the Update All Slides command to update the entire content all the slideshow.

2
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SLIDESHOWS 

REMOVING SLIDES

Remove selected slides from the slideshow. Note that although the slides are
removed from the slideshow window, the image files themselves are not deleted
from the hard disk.

Click the slide you wish to remove. If you wish to remove more than
one slide at a time, hold down the control key, (shift key on Macintosh)
and click each slide you wish to remove.
• The filename of the selected slides is highlighted.

• To cancel removal of a selected slide, hold down the control key, (shift key on
Macintosh) and click the slide once more.

1

On the Slideshow menu, click Remove Selected Slides.
• Use the Remove All Slides command to remove the complete contents of the

slideshow.

• The following dialog box opens on Windows® systems.

2

Click the Yes button to remove the slides. Click the No button to cancel
the operation.
• Macintosh users do not see the above mentioned dialog box. Selecting either

Remove Selected Slides or Remove All Slides from the Slideshow menu will
immediately remove the contents of the slideshow.

3
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SLIDESHOWS 

ADDING AUDIO TO A SLIDE

Add audio to image files for use in slideshows. Macintosh users can use audio
added in the Viewer Panel in Slideshows.

Click the microphone icon shown in the upper right quarter of the
image file to which you wish to add audio. Next, click Record on the
pop-up menu that opens.
• The Record dialog box opens.

1

Click Record on the pop up
menu.

Click and hold on the microphone icon.

▼

▼

Click the Record button “ ” to begin recording audio data.
Use the built-in microphone, or a microphone connected to the sound
board to record audio data.
• The maximum amount of time which can be recorded depends on how much

memory your computer has; the elapsed recording time will appear in the progress
bar of the Record dialog box.

• Click the Stop button “ ” to stop recording.

• Click the Play button “ ” to play back your recording.

• Re-record as many times as necessary until you are satisfied.

▼

■

●2
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SLIDESHOWS 

The microphone icon changes to a speaker
icon.

Replay the audio data.

Delete the audio data.

Click and hold on the speaker icon.

▼

Click the Save button.
• The audio data is saved.

• The microphone icon in the upper right hand corner changes to a speaker icon.

3

Click and hold on the speaker icon. Next, the pop-up menu opens.
• Click Play to replay the audio data. Click Delete to remove the audio data. The

speaker icon will change to a microphone icon.

4
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SLIDESHOWS 

▼

▼

ADDING BACKGROUND MUSIC

Add background music to the slideshow. Windows® users must specify a WAV
file; Macintosh users, an AIFF file.

On the Slideshow menu, point to Background Music, and click Select
on the submenu (Select AIFF on Macintosh).
• This operation can also be performed by clicking the Select Music button on the

toolbar (Background Music on Macintosh).

• The standard Open File dialog box for your operating system opens.

1

(For Windows®) (For Macintosh)
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SLIDESHOWS 

Select the sound file you wish to use as background music, and click
the OK button.
• The selected file is designated as background music for the slideshow.

2

On the Slideshow menu, point to Background Music, and click Play on
the submenu.
• The designated sound file plays.

• Click Stop on the submenu to stop the playback.

• Click Delete on the submenu to remove the background music from the slideshow.

3
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SLIDESHOWS 

▼
▼

SLIDESHOW PREFERENCES

Specify your preferences for slideshow presentations.

On the Slideshow menu, click Slideshow Preferences.
• The Slideshow Preferences dialog box opens.

1

(For Windows®)

(For Macintosh)
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SLIDESHOWS 

Specify your preferences.2

Click the OK button.
• The new settings are saved, and the Slideshow Preferences dialog box closes.

• Click the Default button to return all settings to their default values.

• Click the Cancel button to cancel all changes, and close the dialog box.

3

Return all settings
to their default
values.

Advance to the next slide after the interval (in seconds) shown in the text box.

Advance to the next slide with a mouse click.

Cancel changes,
and close the dialog
box.

When selected, the image is
automatically enlarged or reduced to fit
the monitor screen.

When selected, the filename is
displayed together with the image.

When selected, the slideshow continues
indefinitely

When selected, the slideshow always
begins with the first slide, even when
paused mid-way.

Select a new background colour.

Save the new settings and close the
dialog box.
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SLIDESHOWS

PRESENTING A SLIDESHOW

Present the slideshow on your computer.

On the Slideshow menu, click Present Slideshow.
• This same operation can be performed by clicking the Present button on the

toolbar.

• The slideshow is presented in accordance with the preferences specified as shown
on the previous page.

• Push any key on the keyboard to terminate the slideshow.

1

(For Windows®) (For Macintosh)
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SLIDESHOWS 

▼
▼

Save the slideshow as a file on your hard disk.

SAVING A SLIDESHOW

With the content of the slideshow displayed in the Slideshow window,
on the File menu, click Save As.
• The standard Save As dialog box for your operating system opens.

1

(For Windows®) (For Macintosh)

Select a folder in which to save the file.
• To create a new folder, click the Create New Folder icon (New for Macintosh).

• Click the Cancel button to cancel the operation and close the dialog box.

2

Input the new filename.3

Click the Save button.
• The slideshow is saved as a file in the specified folder.

• To open slideshow files, click the Open File icon on the Digita Desktop control
panel.

4
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SLIDESHOWS 

SAVING THE SLIDESHOW AS AN AVI FILE.
SAVING THE SLIDESHOW AS A QUICKTIME MOVIE FILE.

Convert a slideshow into AVI file format (Windows®) or QuickTime movie file for-
mat (Macintosh).

AVI files and QuickTime movie files are the standard video file formats for
Windows® and Macintosh respectively. Files saved in these formats can be
played with standard applications supplied with the operating system such as the
Windows® MediaPlayer and Macintosh MoviePlayer.

By converting a slideshow into one of these file formats, it can be viewed even
on a computer which has not had the Digita Desktop installed.
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SLIDESHOWS 

▼
▼

With the content of the slideshow displayed in the Slideshow window,
on the Slideshow menu, click Export to AVI (Export to QuickTime
movie on Macintosh).
• The appropriate Export dialog box opens.

1

(For Windows®) (For Macintosh)
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SLIDESHOWS 

Select a frame size, and click the OK button (Save button on
Macintosh).
• The standard Save File dialog box for your operating system opens.

• Click the Cancel button to cancel the operation and close the dialog box.

2

Select a folder in which to save the file.
• To create a new folder, click the Create New Folder icon (New for Macintosh).

3

(For Windows®)

(For Macintosh)
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SLIDESHOWS 

Enter a file name in the text box.4

Click the Save button.
• The slideshow is saved as either an AVI file or a QuickTime movie file in the

specified folder.

5
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VERIFYING THE DIGITA DESKTOP VERSION 

FOR WINDOWS® 95/98/NT

Turn on your computer and start Windows®.1

Open the Digita Desktop folder, and click the Digita Desktop.exe icon.
• Unless the folder designation was changed during setup, the Digita Desktop.exe file

is located in C:\Program Files\FlashPoint\Digita Desktop.

• The EXE extension may not be visible on some computers.

2

Right-click the highlighted Digita Desktop.exe icon.
• The file menu opens.

3
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VERIFYING THE DIGITA DESKTOP VERSION 

▼

On the file menu, click Properties.
• The File Properties dialog box for Digita Desktop.exe opens.

4
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VERIFYING THE DIGITA DESKTOP VERSION 

Click the Version tab, then click Product Version in the Item Name col-
umn.
• The version number is displayed in the Value column.

5

Click the OK button to close the dialog box.6
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VERIFYING THE DIGITA DESKTOP VERSION 

▼

FOR MACINTOSH

Turn on Macintosh and start the Mac OS.1

Open the Digita Desktop folder, and click the Digita Desktop icon.
• Unless the folder designation was changed during setup, the Digita Desktop icon is

located in the folder which was specified during installation.

2

On the File menu, click Get Info.
• The Info window appears displaying the version number.

3

Click the Close button to close the window.4
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USER TECHNICAL SUPPORT

Please contact your dealer for additional information. If your dealer is unable to
help you, contact us.

TECHNICAL SUPPORT

WWW: http://www.minolta.co.uk

Phone: 01-908-208-349
01-908-208-334

Address: Minolta (UK) LTD. Photographic Division
Precedent Drive,
Rooksley, Milton Keynes, MK13 8HF, England

http://www.minolta.co.uk
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